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Questions About the Read-Along Format

WHY: The benefits of reading aloud to children have been marked, studied and
proven for decades. Reading to young learners can make a strong impression
they will remember. But of course, that can be difficult to schedule. Creating
read-along books allows you to supply an important need available anytime,
yet preserve the personal touch and intimate experience of the people you care
about hearing your voices.

WHO: Parents, teachers, children’s book authors and librarians all have ready-
made audiences who are hungering to hear their voice. The benefits of reading
aloud live are inarguable: but providing them with a resource they can come to
again and again on their own will leverage that success.

WHEN: The process of building a read-along book will give you rehearsal for
reading it well to your audience. As you work, you’re practicing how to deliver
the narration clearly and with great sense and empathy. When the read-along
book is done you’ll be ready! And your first book will serve as a terrific template
for those that follow.

HOW: Making a read-along book can be a terrific creative experience, and this
guide aims to make it as easy as possible. It’s normal to feel some anxiety or
hesitation about this, but all you need is a PC, a fairly good microphone, a
quiet place to work and the desire to help younger learners read.

Will Hahn is a fantasy author and professional audiobook narrator, a lifelong
History teacher now also helping students with Creative Writing and Computer
Literacy. He lives and works in Delaware with a wife more lovely than he can
say, a daughter more miraculous than he can describe, and cats more
numerous than you would believe. You can reach him at
will@williamlhahn.com .

J.M. Ashmore is an experienced pediatric nurse, children’s church teacher
and animal lover. She has several decades of experience telling stories and
teaching in schools, churches, and hospitals. She lives with her husband in
Tampa, Florida, and enjoys gardening, photography, and playing the piano and
violin. Her website is https://author-2.com .
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1) What’s the First Step?

You have two main choices about the sequence of preparing a read-along book:

» If you want to start with the artwork, Go to Chapter 2
» If you want to start with the narration, Go to Chapter 3

Neither one is better, it depends what you feel most comfortable with. Maybe
you can'’t get to a good copier or camera for the pictures (or you’re not the
author with access to the files already). Fine, get working on the narration. Or
you still don’t have the microphone, and maybe are (naturally) nervous about
putting your voice out there. Start with the artwork then.

Some folks like a challenge, others want to start closer to the comfort zone. The
secret of read-along books is very simple: you can always try again. In fact,
most of the time you’re spending will be in a second take, a nudge, an
amendment to the process. Nothing is ruined, no work is truly lost here. And
nobody has to hear or see it before you’re good and ready.

Once you have prepared all the elements of the book in Chapters 2 and 3,
Chapter 4 shows you a bit about how PowerPoint (or other presentation
utilities) can bring them together into a book that plays from start to finish
with nice animations and sound. Anyone with a video playing internet device
will be able to download and enjoy your work.

NOTE ABOUT RIGHTS: Briefly, you either need to own the rights to the
material you’re using, or not charge folks to listen. Authors making read-along
books of their own material should consult their publishing contract regarding
rights to the artwork. Non-authors should always prominently display the
author’s name along with the title; as long as you keep your work within the
private community of friends, family and students there should be no issue.
But do not post the work publicly (say, on YouTube) or try to charge money
unless you have consulted the rights holder.



2) Preparing the Artwork
If you are the author of a children’s book, your contract with the artist or
publisher should address the right to use the work for this
purpose. Each drawing should have a separate file (in picture
mode) with high resolution that you can insert to the read-
along project. If you are just making a read-along book for
family and students, you’ll want to take a good quality photo
or photocopy-scan of each drawing page. It’s important to
take the image in good light and flat to the screen: avoid
glare, shadow and curving toward the spine as much as possible.

Save these picture files with a word or two from the name of the book and the
number of the page they are on. Include the
cover of course, and if there is a nice picture at
the end, you can use that for an author’s note or
contact information page. You can also simply
reuse the cover picture for that purpose.
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3) DIY Narration- Yes, You Absolutely Can!

If you're like most people, you don’t enjoy the sound of your own voice when
you hear it played back on a recording. You need to get over yourself on that!
Children love to hear their parents talk, and students their teachers, etc. Over
time, you will get used to the difference in the sound (briefly, you ARE hearing
your voice differently, because when you speak you don'’t really hear it through
the ears, you hear it resonating up the bones in your neck and head!).

That doesn’t mean that the first take you record will automatically be perfect.
Of course you will make mistakes, have to re-record phrases and sentences,
etc. And there will sometimes be noise on the line, or background sounds you
weren’t focusing on because you were concentrating on the words, and more.
It’s all fine. You can always fix it.

You'll need a PC with a recording utility on it, and a

better-than-onboard microphone. Will uses the n »
recording utility Audacity which is absolutely free M AUdaCIty ®
and allows him to create Audible-quality audiobook narration with minimal
processing. Your narration will likely not even need many steps to prepare.

But a good microphone is not negotiable. The PC’s onboard mike will likely
i never produce the quality of sound you need; it’s more like
hearing someone talk from the bottom of a garbage can. But you
don’t have to spend $300 or more on a professional quality
- microphone either—in fact, without a professional studio to go
e ¢ e Wwith it, that money would be wasted. A product like the Blue
Snowball from Logitech costs under $50, and plugs into your PC’s USB port for

easy use when you want it.

It's important to have a quiet place to record. Again, you don’t have to build a
studio; many professional audiobook narrators get good results from standing
near the entrance to a bedroom closet (the hanging clothes provide good
insulation against the sound coming back with too much echo). Will uses a
“soft studio” in his basement (really just a cubicle formed from stapling moving
blankets into the wooden beams): he turns off the house HVAC and records
before his family starts using the bathroom to prevent the sound of trickling
into the pipes!).

Sit or stand comfortably where you have set up your “studio”. Hit the Record
button, wait a couple of seconds, and start to read. Yeah, you’re doing this
now!



Narration Tips

1)

2)

3)

4)

S)

You will need to experiment with the record level of the microphone, the
distance from your mouth to the microphone, and of course the level of
volume you use when you speak. Expression is obviously important but
keep it in control. Practice a consistent, supported voice without either
shouting or running out of gas before the sentence is done!

Make one file for each page of the book. As with the artwork, name each
file with a word from the title and the number of the page. Plus one
called “Open” for the title, author’s name etc. and one called “Close”
where you can thank the audience for listening or help point them
toward more information.

When you record a page, go through its entire script at least twice. That
will give you a second “take” to choose from in case of an accidental
background noise, or if you stuttered, mumbled or mispronounced a
word without realizing it. Cutting out the other take is as easy to do with
sound as it is with words in a word processor.

Save repeatedly. If your program does not autosave, get into the habit of
hitting the Save key before you close the file, walk away or—squirrel!
When you are recording, wait a few seconds before you start speaking
and a few more after you’re done. Then cut the track (it’s as easy as
cutting words from text) to leave about one to two seconds at both ends.

All these tips involve doing something you will start out not wanting to do;
listening to your own voice. Again, get over that, there’s nothing wrong with
your voice, people hear it all the time and like it—join their ranks! But you will
hear takes that you could have done better, sure. In that case, do it better.
Polishing your audio draft is no different than polishing your written work, and
it’s just as easy.

When you have finished recording and trimming your narration file, you will
probably need to convert it from the “native” format of your recording utility to
a format that you can use in your read-along book. Look under the File or Save
menu for the chance to Save-As or Export your file as either a MP3 or WAV
type file. The former are nicely compact and more popular because they take
up less space. Sometimes MP3 files come out with a small stutter or skip in
them due to the compression used. WAV files seldom have that problem but
they do take up more space (on the order of 5 to 10 times as much as MP3).
Try using MP3 first, and if on hearing your finished product you pick up a
sound problem, go back to your original sound file and Export as WAV.



4) Using PowerPoint- Where it All Comes Together
Once you have the artwork and narration files prepared, you’re ready to build
the read-along book. This guide will demonstrate with descriptions and
screenshots taken from The MS Office PowerPoint utility, but Libre Impress
Presentation and Google Slides also have varying capabilities and may work.

When you open PowerPoint, it is already set to Landscape mode (wider than it
is tall) and that’s perfect for creating a read-along book. Choose Blank
presentation (all white background), then right-click on the first slide to Format
Background. From that side-menu you can pick a solid, gradient, or picture-
filled background that will be used for all the slides (Figure 4.1).
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Figure 4.1 Setting up the slide

Then click on the Title and Subtitle boxes to Delete them. To the right of
Format Background, hit the “X” to get rid of that panel and have a larger space
to design. Over on the left panel, right-click on the small image of the slide and

choose Duplicate Slide over and over, to create exact copies of this template to
build the book.

After the cover page, each slide of this project should contain the same three
major elements:

e A piece of artwork
o A text box with the words for that page in it
e Your narration file

The first two are what you see and the last is what you hear.

Place the artwork to one side of the slide and the text box to the other. You
should probably vary that placement through the book: two or three slides with
the text on the left, then switch to the art on the left, etc. Choose Insert-Shape-




Text Box and let the box fill most of one half of the slide. Right-click on the box
to choose a white background, and then pick a Sketched Outline, as in Figure
4.2:
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Figure 4.2 Creating the text box

Later, you will install the actual text of the page in several new text boxes that
overlay this one: keep the background blank/empty and size those word-boxes
so that they fit inside this one. Don’t worry about the overall size of the main
box yet, see how many words you have to deal with and then move the edges to

make it fit.

Now Insert-Picture and choose the artwork that goes with this page. Use the
arrow keys to position it on the other side of the slide from the text box.
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Figure 4.3 Adding the Artwork

Now add the text boxes to hold the words to your main white box. Why several
boxes? Because you want your audience to read-along, and that means
animating one or two sentences at a time. This is where you will spend some
significant effort because each slide needs to be timed out into one smooth-

flowing reading experience.
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Figure 4.4 Preparing text for animation
Notice the main text box can be shortened once you see how many words are
on this page.

Finally, add the narration file you recorded to the page with Insert-Media (over
on the right)-Audio. The file comes in as a light grey speaker icon right in the




center of your slide. Click-drag it off the slide to one side so it doesn’t show
when you create the final project.
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Figure 4.5 Placing the narration file

Lather-rinse-repeat for all the pages in your read-along book.

Now comes the magic part. You will do two main things to create a video in
read-along format:

1. You will create Transitions between each “page” of the book
2. You will use Animations to make the words appear on each “page”.

Does this take time and effort to nudge everything into place? Yes. Totally
worth it to see your children or young audience engaged with the tale you’re
telling.

Transitions determine how each page moves from one to the next. Click on the
Transitions menu and do three things.

First, choose a transition that will apply to THIS slide, how the read-along
project moves TO this slide from the previous one. There are dozens of
transitions to choose from: two that make sense are Page Curl and Peel Off,
because they make it look like the book is reading automatically. As with
varying the box positions, don’t use the same one throughout. But don’t choose
incredibly flamboyant transitions either unless they make sense (perhaps if
you'’re telling the story of The Little Prince you could use something like the
Airplane transition once).

Next, look to the right and reduce the Duration box to 0.01.

Finally, on the far right, change the Advance Slide menu; uncheck On Mouse
Click and select After, then type in a number of seconds equal to the length of




the narration file you have installed. If you leave a second or so at the end of
your narration file, that will give the readers a good pause between “page-

turns”. If you cut your narration file tight to the end of your speaking, you can
add an extra second here.
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Figure 4.6 The Transitions menu

Airplane Origami

Options > | 155 Apply To All

m)

Animations determine how the various elements WITHIN each slide appear,

the order, style and duration of the visual and audio portions of your read-
along book.

Click on the Animation menu, and choose Animation Pane from the center-top

of the screen. That brings up another pane to the right where you can make
your choices.
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Figure 4.7 The Animations menu

Once you click on an element—a text box, picture or the narration file—and
add any kind of Animation to it, that appears in the list to the right under the
Animation Pane. Drag the narration file to the top of the list and click to the
right of its icon, to choose Start With Previous. In this case “previous” means
the transition to this slide from the one before it, so the narration will start
about a second after the slide appears. See Figure 4.8.
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Figure 4.7 Setting the Sequence

Then click on the top text box containing the first words spoken in the
narration file. First, choose what kind of Animation should be used. Those are
available in the upper left of the control menu, just where the Transitions were
in the Transitions menu. Fade is a good one, but Float In (from bottom) and
Wipe can also work. You can vary the Animations you use, but be careful not
to get so fancy that the audience starts to look for the next surprise rather than
pay attention to the story! You can vary the speed, direction and other aspects
of these animation choices by clicking on the drop-down arrow to the right of
the element in the Animation Pane and choosing Effect Options.

Now for the timing. Set this text box to Start with Previous as well; then Click
to the right of the Animation Pane on the little drop-down arrow to choose
Timing. In the Timing menu, pick a short delay, one to two seconds, so that the
words start to appear at about the time the narration actually begins
(remember, you left about a second of blank space at the start of the narration,
right?).
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Figure 4.8 Timing the Text

With the second text box, set it to Start With Previous, and then set the Delay
to match the TOTAL time of the narration so far. If the first text box had a
delay of 2 seconds, and took about 4 seconds for your narration to read the
text, the second box should have a delay of 2 + 4 = 6 seconds. If this second
box took 3 seconds to read, the third text box should have a 9 second delay,
and so on.

This can be a somewhat painstaking process, but it’s not really complicated.
You can save time by Duplicating the finished slide, maybe changing where the
artwork and text box are, but saving the word boxes to the animation and
sequence are already preset. You just change the artwork, as well as the size of
the word-boxes and overall text box to match the new text of the next page.

As you are building a page, you will want to listen and watch it to see if your
timing is correct or needs to be nudged. On any slide, you can click on the
Slide Show menu, and then either on the Current Slide icon at the top or the
little projection easel at the bottom. Either way, the slide you are working on
will fill the screen and the story should play. This way you can check to be
sure:

e Your Transition worked properly

e Your Narration begins a second after the slide shows (you DID click Start
With Previous, right?)

e Your text boxes appear as the narration comes to them

You can also return to the top-cover slide and see if the whole story so far plays
out as it should.
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Figure 4.9 Reviewing Your Work

That’s really all there is to it! Once you have completed all the slides/pages
in order, and are satisfied with the results, of course save the file. Then you
can click on File-Save As, and from the File-Type drop-down menu choose MP4
format.
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Figure 4.10 Converting to Video

The conversion process takes several minutes and the resulting MP4 file is
usually quite large. But this is a format that can be uploaded to a cloud facility
like MS One Drive or Google Drive, or (if you have permission) to YouTube so



that anyone with a device can click to the link you share and read along with
the book.

But isn’t there more to it?

Honestly? Really truly? Well, yes of course, you can always do more with the
read-along format, like add animations to the artwork (zooming in on a
character’s face) or inserting FX to your narration (such as storms, doors
closing, almost anything depending on the story). You could really explore the
storyteller style and imitate the characters with distinct voices, add echoes to
calls for help, and any number of more creative choices. These instructions will
give you a solid template for producing an entire read-along format book, but
you can take it as far beyond that as you wish.

You may also choose to use another presentation utility than PowerPoint, or
something besides Audacity to record your voice. Even if you use these, you
may experience hassles or problems. By all means give us your feedback on
what we could add or change to make this guide clearer to you, and let us
know how you’re doing.

We strongly believe that telling stories is the most truly human of activities.
Parents, teachers, storytellers of all kinds reading to others provide vital
assistance as we all try to understand our world and lives. We hope this guide
will help you to tell stories in your own unique way.

Copyright Notice: This work is the sole property of the authors, Will Hahn and
Janet Ashmore. It is intended for the edification of team members, colleagues
and others whom they intend. You should not distribute this Guide or any part
of it without permission from the authors. Thank you.



